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Accessing TIBCO Business Studio Help

You can access TIBCO Business Studio Help either online when using TIBCO Business Studio or by
downloading it for use at any time.

TIBCO provide Out-Of-Cycle updates of product documentation. If you have downloaded the help already,
and want to be notified of these updates for TIBCO Business Studio, navigate to the current version of
TIBCO Business Studio documentation on the TIBCO Product Documentation page, and click Subscribe to
subscribe to the RSS feed. When notified of an update you can re-download the html from the Product
Documentation site to use the latest version. Copy it to the location of the existing help and access it from
TIBCO Business Studio, or download it as described below to replace previously downloaded help.
Alternatively you can go back to Preferences and re-download the help from there.

If your environment requires accessing of the internet via a proxy then go to Window > Preferences >
General > Network Connections and configure the proxy settings.

Procedure

1. Go to the Help menu.

2. Select Download Offline TIBCO Help.... This guides the user to the appropriate Preferences page
(Preferences > TIBCO Help > Content).

● Content access strategy: Prefer offline help (if available). (default) is already selected, but online
help will be used until help is downloaded. The alternative selection is Always use online help.

● To define where you want the offline help to be located, Browse to the location in which you want
to save the Base offline documentation folder and click Apply. You can click Location to go to the
location that is defined.

● Select the help you want to download and click Download and OK.

● The help is downloaded to the location specified in the Base offline documentation field. If the
Prefer offline Help (if available). content access strategy is selected then then the downloaded help
content will be used. Once the help is downloaded then the Help > Menu items will open the
downloaded offline help.
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Installing TIBCO Business Studio

When you install TIBCO Business Studio, two installation modes are available: GUI and silent.

Before installing TIBCO Business Studio you need to ensure that you have the correct system requirements.
See System Requirements.

After installation, there are post installation tasks you may need to perform. See Perform Post Installation
Upgrade Tasks.

Installation Features
Different installation features are available that allow you to customize the installation of TIBCO Business
Studio components.

The table lists the features you can select. To install additional features, select Customize Installation and
select additional features.

If you install the Process Simulation feature or the Openspace Gadget Development feature, you must
have BPM Development Tools selected.

Feature Selected by Default

BPM Development Tools Yes

Process Simulation No

Workspace Client Components No

Openspace Gadget Development No

Apache Directory Studio (LDAP Tools) Yes

System Requirements
Make sure that your target computer meets the necessary system requirements to install TIBCO Business
Studio.

The system requirements are also listed in the readme file, which is available in the installation set in the
\docs folder or from the TIBCO download site.

Supported Platforms
TIBCO Business Studio - BPM Edition is supported on various platforms.

Note that:

● The Supported Versions specified are the minimum versions of each operating system that are
supported by TIBCO Business Studio. Any subsequent services packs, updates, patches or fix packs (as
appropriate) for the specified versions are also supported.

● Other (64-bit) Linux implementations detailed in the following link have not been formally validated,
but have no known incompatibilities with this version of TIBCO Business Studio.

http://www.eclipse.org/eclipse/development/plans/eclipse_project_plan_4_7.xml#target_environments

● On Linux platforms, the threshold value for the maximum number of open files/file descriptors that a
user can open is typically too low for use with TIBCO Business Studio. You should increaase this value
to at least 10000. (You may need to increase it further depending on the features selected during
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installation and the size of the workspace, but this value is typically sufficient.) You can use the ulimit
-n command to display the current value on your system.

TIBCO Business Studio - BPM Edition (64-bit)

Operating
System (64-bit) Supported Versions

Supported
Processor
Architectures

Windows Microsoft Windows 10 x86-64

Windows Server
● Windows Server 2016

x86-64

Linux
● SUSE Linux Enterprise Server 12.1 to 12.2

● Red Hat Enterprise Linux Server v6.x/6.3 - 6.9, and
v7.x/7.1 - 7.4

● CentOS Linux v6.x/6.3 - 6.9, and v7.x/7.1 - 7.4

● Oracle Linux v6.x/6.3 - 6.9, and v7.x/7.1 - 7.4

x86-64

Minimum Disk Space and Memory Requirements
TIBCO Business Studio requires minimum disk space for installation and minimum memory requirements
in order to run efficiently.

● Free disk space: from 2 GB to 3 GB depending on options selected for installation.

● Memory: minimum 4 GB RAM; the recommended level is 8 GB, or more depending on project sizes.

You should increase the maximum memory size setting (-Xmx) in TIBCOBusinessStudio.ini to 2048m if
you have large or complex projects and have the recommended 8GB memory.

Third-party Software Requirements
Additional third-party software is required when you install TIBCO Business Studio.

The following software and assemblies are required:

● JRE 1.8.x (included in installation). We recommend that users stay up to date with Java patches issued
by Oracle.

● Hibernate Version 3.2.7
(assembly_tibco_com_tibco_tpcl_org_hibernate_feature_3.2.500.002.zip).

You must use a Hibernate Assembly that you have downloaded from TIBCO or the installation
will fail.

During the installation process for TIBCO Business Studio, you can do one of the following:

— Allow the TIBCO Business Studio installer to automatically download and install Hibernate.

— Install TIBCO Business Studio using a Hibernate assembly that you have previously downloaded
from TIBCO. During installation, you will be asked to specify the directory where you downloaded
Hibernate.

If you want the installer to automatically install Hibernate, make sure you are online.
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When downloading Hibernate, the number in the package name refers to the assembly
number and not the version of Hibernate. This can be misleading as the assembly number is
not the same as the Hibernate version number. For example, the package name when
downloading Hibernate Version 3.2.7 is
assembly_tibco_com_tpcl_ord_hibernate_feature_3.2.500.002.zip.

● Oracle Elliptic Curve Cryptography Library 1.8.x (product_tibco_sunec_1.8.x_<platform>.zip)

product_tibco_sunec_1.8.x_<platform>.zip should be copied into the assemblies folder
for silent installation (when there is no option to specify the path). See Installing in Silent
Mode (All Platforms)).

● Eclipse SWT (Standard Web Toolkit) GTK

The TIBCO Business Studio installer for Linux 64 bit distributions downloads the Eclipse SWT GTK
module which contains these two items:

— The Free Software Foundation, Gnome Binding

— The Free Software Foundation, GTK+ Binding

The zip file required is as follows:

— product_tibco_eclipse_lgpl_4.7.1.001_linux24gl23_x86_64.zip

During the installation process for TIBCO Business Studio the steps are very similar to using
Hibernate. An installation dialog comes up for accepting the license and then gives an option to
download the assembly from the TIBCO public website or select it from the disk.

You require a minimum GTK+ version 2.24.

Compatibility
TIBCO Business Studio version 4.3.2 is compatible with specific versions of other TIBCO products.

The products that TIBCO Business Studio version 4.3.2 is compatible with are as follows:

● TIBCO BPM Enterprise 4.3.2

● TIBCO ActiveMatrix® Service Bus 3.4.1

● TIBCO ActiveMatrix® Service Grid 3.4.1

TIBCO Business Studio should have the appropriate level of ActiveMatrix Platform HotFix for
the BPM server that you wish to connect to.

● TIBCO Nimbus™ 10.0.0 to 10.x

● TIBCO Business Studio™ ActiveMatrix® Decisions Add-In 1.4.0 - 1.4.x

If you are using TIBCO ActiveMatrix Service Bus or TIBCO ActiveMatrix Service Grid you must ensure that
you also have the ActiveMatrix Platform Hotfix version that is compatible with the ActiveMatrix BPM
server that you are using.

Installer Accounts
You require certain privileges to install TIBCO Business Studio on Windows and Linux/UNIX platforms.

Microsoft Windows

You must have administrator privileges for the machine on which TIBCO Business Studio is installed. If
you do not have administrator privileges, the installer exits. You must then log out of the system and log in
as a user with the required privileges, or request your system administrator to assign the privileges to your
account.
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After installing TIBCO Business Studio with administrator privileges, do not use the same account to create
a workspace for the user. Instead, individual users should start TIBCO Business Studio from the account
with which they intend to use TIBCO Business Studio, and create their own workspace to avoid potential
issues with permissions.

If you intend to install the product on a network drive, you must ensure that the account used for
installation has permission to access the network drive.

Linux/UNIX

TIBCO Business Studio can be installed either as a root or a local user. TIBCO recommends that you install
as the user you plan to use for TIBCO Business Studio to avoid any potential permissions issues.

Installation Directories
You must install each version of TIBCO Business Studio into a new, empty installation environment
(separate from earlier versions of TIBCO Business Studio or other TIBCO products).

Do not install into the existing TIBCO_HOME directory, which is the default option.

You should create a new workspace for each installation of TIBCO Business Studio.

To do this, install TIBCO Business Studio as described in Installing in GUI Mode on Windows. Specify a
new, empty directory or create a new, empty directory as the environment location.

You may install TIBCO Business Studio into an existing installation environment if:

● you are reinstalling the same edition and version of TIBCO Business Studio in order to repair a corrupt
installation.

● you are sure none of the existing products in that installation environment conflict with the edition and
version of TIBCO Business Studio that you are installing.

Installer Log File
The installer log file is written to specific locations for Windows and Linux.

Windows 10, Windows Server 2016

User_Home\.TIBCO\install_identifier directory where identifier is in the form of the date and time
TIBCO Business Studio was installed and a unique number used to identify this particular installation of
TIBCO Business Studio.

For example, C:\Users\user-name\.TIBCO\install_03-02-2010.132827

Linux/UNIX

$HOME/.TIBCO/install_identifier directory where identifier is in the form of the date and time TIBCO
Business Studio was installed and a unique number used to identify this particular installation of TIBCO
Business Studio.

For example, /home/user1/.TIBCO/install_03-02-2010.132827

Environment Information

The file _envInfo.xml is written to this location for Windows: C:\Program Files\Common Files
\InstallShield\Universal\TIBCO\Gen1\_vpddb.
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Installing in GUI Mode on Windows
This procedure explains how to install TIBCO Business Studio in GUI mode. Hibernate is also installed as
part of the installation process.

Prerequisites

Log in to the system on which you want to install TIBCO Business Studio (for more information, see 
Installer Accounts). If you want the installer to automatically install Hibernate 3.2.7, make sure you are
online. See Third-party Software Requirements for more information.

Open the physical media or download the TIBCO Business Studio package to the machine on which you
want to install TIBCO Business Studio.

Extract the installation files to a temporary directory.

Procedure

1. Double-click TIBCOUniversalInstaller.

2. Review the information in the Welcome dialog and click Next.

Review the terms of the license agreement and, if you agree to them, click I accept the terms of the
license agreement. Then click Next to continue with the installation.

If you do not agree to the terms of the license agreement, click Cancel to exit from the installation
process.

3. From the TIBCO Installation Home dialog, TIBCO_HOME is the preferred top level installation
directory for all TIBCO products on your system. Select either:

● Create a new TIBCO_HOME. Click Browse to specify an environment location (a directory path to
an empty folder into which the software will be installed), or accept the default environment
location (which is the last directory in the path selected).

● Use an existing TIBCO_HOME. Select an existing TIBCO_HOME from the drop-down list.

You should provide your own environment name (by default environment name is empty). If this
is not the first installation of TIBCO software, you should give different environment name than the
already existing one.

Click Next.

4. On the Installation Profile Selection dialog, accept the selection of Solution Designer profile in the list
in the left hand pane (see Installation Features) or select Customize Installation. See Completing a
Custom Installation on Windows for information on additional steps in the custom installation. The
right hand pane displays the features that are selected for each profile. Click Next

5. Review the terms of the LGPL License Agreement and, if you agree to them, click I accept the terms of
the license agreement. Then click Next to continue with the installation.

If you do not agree to the terms of the license agreement, click Cancel to exit from the installation
process.

6. On the LGPL Assembly Download dialog, select Download Hibernate Assembly from TIBCO or
Provide the location for the assembly previously downloaded from TIBCO.

7. Review the terms of the LGPL License Agreement and, if you agree to them, click I accept the terms of
the license agreement. Then click Next to continue with the installation.

If you do not agree to the terms of the license agreement, click Cancel to exit from the installation
process.

8. On the LGPL Assembly Download dialog, select Download Oracle Elliptic Curve Cryptography
Library as ... or Provide the location for the assembly previously downloaded from TIBCO.
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9. After the installer configures your installation choices, the Pre-Install Summary dialog is displayed.
Review the information displayed in the dialog and make sure that it is correct.

If you want to change any of your choices, click Back to step back through the dialogs to the appropriate
point and make your choices again.

When you are satisfied with your choices, click Install. The installer now performs the necessary
installation tasks.

10. Once the installer has finished the installation tasks, the Running Product ANT Tasks dialog is
displayed. The installer now performs the necessary tasks to initialize the installation. Click Show
Details to see the tasks that the installer is performing. Click Finish to exit from the installer. There is a
slight delay while the installer deletes temporary files.

What to do next

Complete the post-installation tasks described in Perform Post Installation Upgrade Tasks.

Completing a Custom Installation on Windows
A custom installation provides you with more options than an installation using the default settings.

Prerequisites

Log in to the system on which you want to install TIBCO Business Studio (for more information, see 
Installer Accounts). If you want the installer to automatically install Hibernate 3.2.7, make sure you are
online. See Third-party Software Requirements for more information.

Open the physical media or download the TIBCO Business Studio package to the machine on which you
want to install TIBCO Business Studio.

Extract the installation files to a temporary directory.

TIBCO strongly recommend not to install on a customized Eclipse.

Procedure

1. Double-click TIBCOUniversalInstaller.
2. Review the information in the Welcome dialog and click Next.

Review the terms of the license agreement and, if you agree to them, click I accept the terms of the
license agreement. Then click Next to continue with the installation. If you do not agree to the terms of
the license agreement, click Cancel to exit from the installation process.

3. The TIBCO Installation Home dialog appears. TIBCO_HOME is the preferred top level installation
directory for all TIBCO products on your system. Select either:

● Create a new TIBCO_HOME. Click Browse to specify an environment location (a directory path to
an empty folder into which the software will be installed), or accept the default environment
location (which is the last directory in the path selected).

● Use an existing TIBCO_HOME. Select an existing TIBCO_HOME from the drop-down list.

You should provide your own environment name (By default environment name is empty). If this
is not the first installation of TIBCO software, you should give different environment name than the
already existing one.

Click Next
4. On the Installation Profile Selection dialog, select Customize Installation in the left hand pane. In the

right hand pane, all the features are selected except Process Simulation, Workspace Client
Components, and Openspace Gadget Development. You can add or remove individual features,
depending on your requirements. Click Next.
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5. Review the terms of the LGPL License Agreement and, if you agree to them, click I accept the terms of
the license agreement. Then click Next to continue with the installation.

If you do not agree to the terms of the license agreement, click Cancel to exit from the installation
process.

6. On the LGPL Assembly Download dialog, select Download Hibernate Assembly from TIBCO or
Provide the location for the assembly previously downloaded from TIBCO.

7. Review the terms of the LGPL License Agreement and, if you agree to them, click I accept the terms of
the license agreement. Then click Next to continue with the installation.

If you do not agree to the terms of the license agreement, click Cancel to exit from the installation
process.

8. On the LGPL Assembly Download dialog, select Download Oracle Elliptic Curve Cryptography
Library as ... or Provide the location for the assembly previously downloaded from TIBCO.

9. After the installer configures your installation choices, the Pre-Install Summary dialog is displayed.
Review the information displayed in the dialog and make sure that it is correct. If you want to change
any of your choices, click Back to step back through the dialogs to the appropriate point. You can then
restart the installation process from that point. When you are satisfied with your choices, click Install .

10. Once the installer has finished the installation tasks, the Running Product ANT Tasks dialog is
displayed. The installer now performs the necessary tasks to initialize the installation. Click Show
Details to see the tasks that the installer is performing. Click Finish to exit from the installer.

What to do next

Complete the post-installation tasks described in Perform Post Installation Upgrade Tasks

Installing in GUI Mode on Linux/UNIX
You can install in GUI mode on Linux/UNIX using a similar procedure to that used for installing on
Windows, with the addition of acceptance of an extra license file.

Prerequisites

Log in to the system on which you want to install TIBCO Business Studio (for more information, see 
Installer Accounts). If you want the installer to automatically install Hibernate 3.2.7, make sure you are
online. See Third-party Software Requirements for more information.

Open the physical media or download the TIBCO Business Studio package to the machine on which you
want to install TIBCO Business Studio.

Extract the installation files to a temporary directory.

Procedure

1. Run the shell script TIBCOUniversalInstaller-lnx-x nn.bin.

2. Double-click TIBCOUniversalInstaller.

3. Review the information in the Welcome dialog and click Next.

Review the terms of the license agreement and, if you agree to them, click I accept the terms of the
license agreement. Then click Next to continue with the installation.

If you do not agree to the terms of the license agreement, click Cancel to exit from the installation
process.

4. From the TIBCO Installation Home dialog, TIBCO_HOME is the preferred top level installation
directory for all TIBCO products on your system. Select either:
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● Create a new TIBCO_HOME. Click Browse to specify an environment location (a directory path to
an empty folder into which the software will be installed), or accept the default environment
location (which is the last directory in the path selected).

● Use an existing TIBCO_HOME. Select an existing TIBCO_HOME from the drop-down list.

You should provide your own environment name (by default environment name is empty). If this
is not the first installation of TIBCO software, you should give different environment name than the
already existing one.

Click Next.

5. Choose a profile from the list in the left hand pane (see Installation Features). The right hand pane
displays the features that are selected for each profile. Click Next.

6. Review the terms of the LGPL License Agreement and, if you agree to them, click I accept the terms of
the license agreement. Then click Next to continue with the installation.

If you do not agree to the terms of the license agreement, click Cancel to exit from the installation
process.

7. Accept the Gnome License Agreement which uses the LGPL License. Click on Download Gnome
Binding assembly from TIBCO.

8. After the installer configures your installation choices, the Pre-Install Summary dialog is displayed.
Review the information displayed in the dialog and make sure that it is correct.

If you want to change any of your choices, click Back to step back through the dialogs to the appropriate
point and make your choices again.

When you are satisfied with your choices, click Install. The installer now performs the necessary
installation tasks.

9. Once the installer has finished the installation tasks, the Running Product ANT Tasks dialog is
displayed. The installer now performs the necessary tasks to initialize the installation. Click Show
Details to see the tasks that the installer is performing. Click Finish to exit from the installer. There is a
slight delay while the installer deletes temporary files.

Failures in Linux Version 7 when TIBCO Business Studio uses the SWT Internal Browser
There are failures in Linux Version 7 (OEL7, CentOS 7, RHEL 7) when TIBCO Business Studio uses the SWT
internal browser (used for BPM Live Dev, Email Service Task, TIBCO Product Help view) and an error
message is displayed.

You will see the following error:

When you click OK you see the following error message.
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To fix this you must install 64-Bit XULRunner 1.9.2. You need to download this from the Mozilla nightly
builds site: http://ftp.mozilla.org/pub/mozilla.org/xulrunner/nightly/2012/03/2012-03-02-03-32-11-
mozilla-1.9.2/

1. Extract the contents of the tar file by entering the following command: tar -xvif tar-file-name

2. To make the new XULRunner version available, update the TIBCO Business Studio .ini file and add
the following Java VM arguments (vmargs) in the file: -
Dorg.eclipse.swt.browser.XULRunnerPath=pathto-XULRunner.

● Note: This update applies to a specific instance of TIBCO Business Studio. If the instance of TIBCO
Business Studio was installed for an individual user, the update only applies to that user. If TIBCO
Business Studio was installed as a shared instance that is used by multiple users, the update applies
to all users of the shared instance.

● The following procedure makes the new version available to all users on the system:

— As user root, extract the XULRunner runtime directory to a location that is accessible to all
users, for example, /usr/lib/xulrunner-1.9.2.

— From the XULRunner directory, enter the following command:./xulrunner --register-
global

● The following procedure makes the new version available to an individual user

— Extract the XULRunner runtime directory to the home directory of the user.

— From the XULRunner directory, enter the following command:./xulrunner --register-user

Registering XULRunner persists across the system and TIBCO Business Studio
restarts.

3. Restart TIBCO Business Studio and confirm that the issues have been resolved.

Installing in Silent Mode (All Platforms)
You can install TIBCO Business Studio in silent mode on all platforms.

Prerequisites

The TIBCOUniversalInstaller.silent file is packaged in the directory that contains the universal
installer. You must edit the file with information for your environment before launching the silent
installation. The file includes comments that describe the installation properties you can set.

While you can use the TIBCOUniversalInstaller.silent file, it’s good practice to copy the file to a
different name and use that file for the silent install.

If errors occur during installation, they will be listed in the installation log file (see the User_Home/.TIBCO
directory).
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Procedure

1. Open the physical media or download the TIBCO Business Studio product package.

2. Extract the TIBCO Business Studio product archive file to a temporary directory.

3. Using a console window, navigate to the temporary directory that contains the universal installer.

4. Copy the TIBCOUniversalInstaller.silent file and name the file.

5. Using a text editor, open the copied file and update the install location, and the list of features to install.

6. Run the installer: TIBCOUniversalInstaller -silent -V responseFile="myfilename.silent"

If you are using the TIBCOUniversalInstaller.silent file, you need not supply the file name and can
run: TIBCOUniversalInstaller -silent.
Oracle Elliptic Curve Cryptography Library (product_tibco_sunec_1.8.0._x<platform>.zip)
should be copied into the assemblies folder.

What to do next

Complete the post-installation tasks described in Perform Post Installation Upgrade Tasks.
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Perform Post Installation or Upgrade Tasks

After installation, there are a number of tasks you can perform to ensure that your system runs efficiently.

Deletion of the Temporary Installation Files
If you want to recover the disk space used by the installation files that you extracted to a temporary
directory in step 3 of the installation, delete them.

Issues to be Aware of when Running on Linux
If you are running on Linux, you should be aware of the following notes.

If you want to run TIBCO Business Studio in "headless" mode on Linux for command line build and deploy,
it is necessary to have the Xvfb service running as some of the underlying eclipse components require an X
Window System running on *NX based operating systems.

The examples below are for Red Hat Linux (x86_64). You can tailor these steps to your own installation.

In text terminal mode (a default Red Hat 6 runlevel 3 for example) you can use Xvfb to run X Window
Virtual Frame Buffer:

1. Install the Virtual Frame Buffer package for X11 if it is not already installed. If this is not available in the
base repository of Red Hat you should enable one of Red Hat specific package repositories.

yum install xorg-x11-server-Xvfb.x86_64

2. export DISPLAY=:1

3. xvfb-run <your ant script

Or alternatively:

4. yum install xorg-x11-server-Xvfb.x86_64

5. export DISPLAY=:1

6. Xvfb :1 > /dev/null 2>&1 &

7. ....<run your ant script

The other solution is simply to start the X Window server.

Redeploy Custom WCC Applications
If you have upgraded TIBCO Business Studio, the install also upgrades WCC design-time software. If you
had previously used TIBCO Business Studio to develop and configure a custom WCC application, you
must redeploy the WCC application after upgrading TIBCO Business Studio to pick up any new
functionality that was installed in the upgrade.
The following is a summary of the main tasks that need to be performed to redeploy a custom WCC
application. For more details, see "Deploying an Application After Customizing" in the TIBCO Workspace
Configuration and Customization guide.

Procedure

1. Create a new WAR file for your custom application.

2. Copy the WAR file to TIBCO Business Studio.

3. Create a DAA for the application.

4. Undeploy the previously deployed custom application using TIBCO Administrator.

5. Deploy the DAA created in Step 3 to the runtime node using TIBCO Administrator.
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Uninstalling TIBCO Business Studio

To uninstall TIBCO Business Studio from your system, perform the following steps:

When you uninstall, some files are currently left behind that are not user data. You can remove these files
manually if required.

Linux\UNIX

1. Open a terminal.

2. Navigate to STUDIO_HOME/tools/universal_installer.

3. Run the uninstaller named TIBCOUniversalInstaller-lnx-x86-64.bin.

Windows

Either:

● Use the uninstaller provided with TIBCO Business Studio or

● Remove the installation using the Programs and features option in Control Panel on Windows System.

When you installed TIBCO Business Studio, if the installer detected a suitable Java Virtual
Machine (JVM), that JVM is used by TIBCO Business Studio. The uninstallation will fail if you
remove the JVM used by TIBCO Business Studio before removing TIBCO Business Studio. If
this happens, you can use the command line to uninstall with the -is:javahome option.

To do this, navigate to the STUDIO_HOME/tools/universal_installer folder and enter the
following command TIBCOUniversalInstaller-x86-64.exe -is:javahome <JRE_HOME>

Using the Uninstaller
Uninstall TIBCO Business Studio using the uninstaller.

Procedure

1. Log in to the system on which you want to uninstall software.

2. The Welcome dialog is displayed. Click Next.

3. Do one of the following:

● Select Typical to uninstall all products in the environment, and omit the next step.

● Select Custom to choose products in this environment to uninstall , and continue with the next
step.

4. The Product Uninstall Selection dialog is displayed. Select the products (for example, TIBCO Business
Studio 3.9.0) you want to uninstall and click Next.

5. The Ready to Uninstall dialog is displayed. If you want to change any of your choices, click Back to
step back through the dialogs to the appropriate point. You can then restart the uninstallation process
from that point. When you are satisfied with your choices, click Uninstall.

The TIBCO Business Studio entries in the Start menus may appear after the uninstallation. To
correct this log out, then log in again.
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Using Programs and Features (Windows Only)
You can remove the installation using the Programs and Features option on your PC.

Procedure

1. Log in to Windows as a user with system administrator privileges. You must have system administrator
privileges to uninstall this software.

2. In the Control Panel, double-click Programs and Features.

3. In the Programs and Features dialog, select TIBCO Universal Installer ( > installation_environment_n
> ) , where installation_environment_n is the directory corresponding to the installation environment
you want to uninstall. If you have installed more than one TIBCO product, there will be multiple entries
in Programs and Features (for example, TIBCO Universal Installer (c:\tibco\env_1), TIBCO Universal
Installer (c:\tibco\env_2), and so on).

4. Click Uninstall/Change.

The uninstaller launches. Follow the uninstallation steps in Using the Uninstaller.

The uninstaller may not completely remove files that have been modified since the initial
installation (for example, the configuration directory). If you do not need any of the other
remaining files, manually delete them.
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TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly in
HTML and PDF formats.
The website is updated frequently and is more current than any other documentation included with the
product.

Product-Specific Documentation

The following documentation for TIBCO Business Studio is available on the TIBCO Business Studio
Product Documentation page:

● TIBCO Business Studio™ Release Notes

● TIBCO Business Studio™ Concepts

● TIBCO Business Studio™ Modeling User's Guide

● TIBCO Business Studio™ - Analyst Edition User's Guide

● TIBCO Business Studio™ - BPM Implementation

● TIBCO Business Studio™ Forms User's Guide

● TIBCO Business Studio™ Simulation User's Guide

● TIBCO Business Studio™ Customization

● TIBCO Business Studio™ - Analyst Edition Installation

● TIBCO Business Studio™ - BPM Edition Installation

● TIBCO Business Studio™ iProcess to BPM Conversion

How to Contact TIBCO Support

Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support website.

● For creating a Support case, you must have a valid maintenance or support contract with TIBCO. You
also need a user name and password to log in to TIBCO Support website. If you do not have a user
name, you can request one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to 
TIBCO Community.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS
OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE
SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH
SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE
LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS
SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE
ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, Enterprise Message Service, Business Studio, and ActiveMatrix
are either registered trademarks or trademarks of TIBCO Software Inc. in the United States and/or other
countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle and/or its
affiliates.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system platforms
for a specific software version are released at the same time. See the readme.txt file for the availability of
this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL
BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED
IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING
BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2004-2022. TIBCO Software Inc. All Rights Reserved.
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